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1. Introduction
Three-dimensional (3D) radiative transfer (RT) modeling of the transport and interaction of 

radiation through earth surfaces is a challenging and difficult task. The difficulties lie in the complexity 
of the landscapes and also in the intensive computational cost of 3D RT simulations. To reduce 
computation time, current models work with schematic landscapes or with small-scale realistic scenes. 
The most accurate and efficient models (known as renderers) are from the computer graphics community, 
but the usages are not straightforward for performing scientific RT simulations. That’s the reason why 
we developed this model.

Basically, LESS employs a forward photon tracing method to simulate bidirectional reflectance 
factor (BRF) or flux-related data (e.g., downwelling radiation) and a backward path tracing method to 
generate sensor images (e.g., fisheye images) or large-scale (e.g. 1 km2) spectral images from visible to 
thermal infrared spectral domain. We also provide a user-friendly graphic user interface (GUI) and a set 
of tools are developed to help construct the landscape and set parameters. LESS has already been 
evaluated with other models in terms of directional BRF and pixel-wise simulated images. It can be used 
as benchmarks for validating physical models or training artificial neural network (ANN) to do parameter 
inversion.

2. Fundamentals of LESS

2.1. Forward photon tracing (FPT)
2.1.1. Photon tracing

Forward photon tracing (FPT) traces photon packets with the power 𝑃𝑃(𝜆𝜆) into the scene from 
light sources. The initial power 𝑃𝑃0(𝜆𝜆) of each packet is determined by the power of light sources 
and the number of generated packets 𝑁𝑁. When generating photon packet in a scene with multiple 
light sources, a light source is randomly chosen according to the importance weight 𝑤𝑤𝑘𝑘, which is 

proportional to the power of each light source, i.e., 𝑤𝑤𝑘𝑘 = 𝐿𝐿𝑘𝑘(𝜆𝜆)
∑ 𝐿𝐿𝑘𝑘(𝜆𝜆)𝐾𝐾
𝑘𝑘=1

 with 𝐿𝐿𝑘𝑘(𝜆𝜆) being the power 

of light source 𝑘𝑘 and 𝐾𝐾 being the number of light sources. This mechanism guarantees that a light 
source with larger power has more sampled photon packets. The initial power of each packet, in 
terms of watt (W), is given as

𝑃𝑃0(𝜆𝜆) = ∑ 𝐿𝐿𝑘𝑘(𝜆𝜆)𝐾𝐾
𝑘𝑘=1

𝑁𝑁
(1)

When a photon packet enters the scene along a path defined by its origin and direction of 
propagation, its intersection with landscape elements is tested for. If an intersection is found, the 
power of this packet will be scaled according to the optical properties of the intersected surface, i.e., 
the reflectance or transmittance. For a packet with 𝑄𝑄 times of scattering before it escapes from the 
scene, the power becomes

𝑃𝑃𝑄𝑄(𝜆𝜆) = 𝑃𝑃0(𝜆𝜆) ∙ ∏ �𝜋𝜋𝜋𝜋(𝑞𝑞,𝜔𝜔𝑖𝑖,𝜔𝜔𝑜𝑜,𝜆𝜆)/𝑝𝑝�𝑄𝑄
𝑞𝑞=1  (2)

where the 𝑓𝑓(𝑞𝑞,𝜔𝜔𝑖𝑖,𝜔𝜔𝑜𝑜,𝜆𝜆)  is the bidirectional scattering distribution function (BSDF) at the 𝑞𝑞th 
intersection point during its trajectory. 𝜔𝜔𝑖𝑖,  and 𝜔𝜔𝑜𝑜  are the incident direction and outgoing 
direction of a photon packet, respectively. Since the scattering law of surfaces in LESS is defined 
as Lambertian, the BSDF is interpreted as bidirectional reflectance distribution function (BRDF) or 
bidirectional transmittance distribution function (BTDF), according to 𝜔𝜔𝑖𝑖,, surface normal 𝜔𝜔𝑛𝑛 and 
𝜔𝜔𝑜𝑜, i.e.,

𝑓𝑓�𝑞𝑞,𝜔𝜔𝑖𝑖,𝜔𝜔𝑜𝑜,𝜆𝜆� = 1
𝜋𝜋
�
𝜌𝜌⊥,𝜆𝜆 ∙ sgn(𝜔𝜔𝑛𝑛 ∙ 𝜔𝜔𝑖𝑖,) + 𝜏𝜏𝜆𝜆 ∙ sgn(−𝜔𝜔𝑛𝑛 ∙ 𝜔𝜔𝑖𝑖,), 𝜔𝜔𝑜𝑜 ∙ 𝜔𝜔𝑛𝑛 ≥ 0
𝜌𝜌⊤,𝜆𝜆 ∙ sgn(−𝜔𝜔𝑛𝑛 ∙ 𝜔𝜔𝑖𝑖,) + 𝜏𝜏𝜆𝜆 ∙ sgn(𝜔𝜔𝑛𝑛 ∙ 𝜔𝜔𝑖𝑖,), 𝜔𝜔𝑜𝑜 ∙ 𝜔𝜔𝑛𝑛 < 0  (3)
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where sgn(𝑥𝑥) = �1, x ≥ 0
0, x < 0; 𝜌𝜌⊥,𝜆𝜆

𝜋𝜋
 and 𝜌𝜌⊤,𝜆𝜆

𝜋𝜋
 are the upper and bottom surface BRDF, respectively; 

𝜏𝜏𝜆𝜆
𝜋𝜋

 is the BTDF. In LESS, the transmittances of the surface from both the upper and the bottom side 

are assumed to be the same; The outgoing direction of a photon packet after scattering is determined 
by randomly sampling the BSDF function. For Lambertian surfaces, the model chooses a random 
direction in the outgoing hemisphere. Since a single photon trajectory can be used to simulate BRF 
for any wavelength by updating the power according to the spectral reflectance/transmittance, we 
have omitted the symbol 𝜆𝜆 in the following equations for simplicity.

A photon packet is collected by the sensor if it exits the scene through the top boundary. Lateral 
boundary effects are considered in order to simulate horizontally infinite scenes with a repetitive 
pattern. As shown in Figure 1, the photon packet which exits from the lateral boundaries will re-
enter the scene from the opposite side with the same photon direction until it escapes through the 
top boundary of the scene. When the scattering order of a packet exceeds a user-defined threshold 
(e.g., 5), the propagation of the packet is randomly stopped according to the “Russian roulette” 
mechanism (Kobayashi and Iwabuchi, 2008), which terminates the trajectory of a packet with a 
probability 𝑝𝑝 (e.g., 5%). If the packet survives, its power will be multiplied by 1

1−𝑝𝑝
.

Figure 1. Forward photon tracing.

The collection of the escaped photon packets is achieved by placing a virtual hemisphere above 
the scene (Govaerts and Verstraete, 1998). As shown in Figure 2, the hemisphere is partitioned into 
𝑁𝑁𝑃𝑃 small surface elements (SE) with equal area 𝛥𝛥𝛥𝛥 = 2𝜋𝜋

𝑁𝑁𝑃𝑃
 by utilizing the partition scheme of a 

disk via the equal area projection, i.e., ∆𝛺𝛺 = 𝛥𝛥𝛥𝛥 . The zenithal zones are partitioned through 
(Beckers and Beckers, 2012):

𝜃𝜃𝑖𝑖 = 𝜃𝜃𝑖𝑖−1 −
2

𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎
sin 𝜃𝜃𝑖𝑖−1

2 �
𝜋𝜋

𝑘𝑘𝑖𝑖−1
, 𝑘𝑘𝑖𝑖 = 𝑘𝑘𝑖𝑖−1 �

𝑟𝑟𝑖𝑖
𝑟𝑟𝑖𝑖−1

�
2
  (4)

Where (𝜃𝜃𝑖𝑖 ,𝜃𝜃𝑖𝑖−1) defines a zenithal zone on the hemisphere with 𝜃𝜃0 = 𝜋𝜋
2
; 𝑘𝑘𝑖𝑖 is the total number of 

SEs inside a zenithal angle 𝜃𝜃𝑖𝑖  with 𝑘𝑘0 = 𝑁𝑁𝑃𝑃 ; 𝑟𝑟𝑖𝑖  is the radius corresponding to 𝜃𝜃𝑖𝑖  with 𝑟𝑟𝑖𝑖 =

2 sin 𝜃𝜃𝑖𝑖
2

 for a unit sphere due to the equal area projection; 𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎 is the aspect ratio of each SE, 

which is approximately enforced to 1. For each zenithal zone, it has 𝑘𝑘𝑖𝑖−1 − 𝑘𝑘𝑖𝑖 SEs with equal area.

Figure 2. Unit hemisphere partition. The hemisphere is projected to horizontal plane as a disk using equal 
area projection. The radius 𝑟𝑟𝑖𝑖 in the disk indicates zenith angle 𝜃𝜃𝑖𝑖 in the hemisphere.

When a photon packet exits the scene, the outgoing SE (solid angle) is determined by the 
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photon direction only, i.e., the hemisphere is placed at an infinite position. The BRF in this SE can 
be estimated with (Govaerts and Verstraete, 1998)

𝑓𝑓𝐵𝐵𝐵𝐵𝐵𝐵𝑖𝑖 = 𝜋𝜋𝑃𝑃𝑖𝑖
𝐴𝐴

∆𝛺𝛺𝑖𝑖∙cos𝜃𝜃𝑖𝑖
𝑐𝑐∙𝑃𝑃𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠

(5)

where 𝑃𝑃𝑖𝑖𝐴𝐴 is the power (watt) of all the captured photons in SE 𝑖𝑖, i.e., 𝑃𝑃𝑖𝑖𝐴𝐴 = ∑ 𝑃𝑃𝑄𝑄𝑃𝑃𝑄𝑄∈∆𝛺𝛺𝑖𝑖 ; ∆𝛺𝛺𝑖𝑖 =
2𝜋𝜋
𝑁𝑁𝑃𝑃

 is the solid angle of each SE; 𝜃𝜃𝑖𝑖𝑐𝑐 is the central zenith angle of solid angle ∆𝛺𝛺𝑖𝑖; 𝑃𝑃𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠 is the 

power of all the direct incident photon packets on a reference plane at the top of the scene, i.e., the 
incident radiation at the top of the scene. Once the power in each SE is determined, the scene albedo 
is computed as

𝜔𝜔𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎 =
∑ 𝑃𝑃𝑖𝑖

𝐴𝐴𝑁𝑁𝑃𝑃
𝑖𝑖=1
𝑃𝑃𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠

  (6)

1.1.1. Virtual photon

The real photon approach (described in section 2.2.1) estimates BRF by using small SEs on the 
sphere. More photon packets are needed to reduce the variance when smaller SEs are used. To solve 
this problem, a virtual photon approach, similar to the virtual direction in DART model (Yin et al., 
2015), secondary ray in Rayspread model (Widlowski et al., 2006) or some “local estimates” 
methods (Antyufeev and Marshak, 1990; Marchuk et al., 1980), is introduced. If a packet is 
intercepted by an object (e.g., a tree) in the scene without complete absorption, the packet will be 
scattered in a direction which is randomly sampled by the BSDF function, and a virtual photon 
packet will be sent to each of the defined virtual directions. The possible scattered energy, in terms 
of intensity (W ∙ sr−1), is calculated as

𝐼𝐼 = 𝑉𝑉 ∙ 𝑃𝑃𝑞𝑞−1 ∙ 𝑓𝑓(𝑞𝑞,𝜔𝜔𝑖𝑖 ,𝜔𝜔𝑣𝑣) ∙ cos < 𝜔𝜔𝑣𝑣,𝜔𝜔𝑛𝑛 > (7)
where 𝑃𝑃𝑞𝑞−1  is the power of the incident photon packet at the 𝑞𝑞th  intersection point along its 
trajectory; 𝜔𝜔𝑣𝑣 is a virtual direction; 𝑉𝑉 is a visibility factor which equals to zero if the a landscape 
element occludes the virtual photon packet, and equals to 1 otherwise. When sending the occlusion 
testing rays, the lateral boundary effect is also considered (Figure 3). The final BRF is then given 
as

𝑓𝑓𝐵𝐵𝐵𝐵𝐵𝐵𝑣𝑣 = 𝜋𝜋𝐼𝐼𝑣𝑣𝐴𝐴

cos𝜃𝜃𝑣𝑣∙𝑃𝑃𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠
 (8)

where 𝐼𝐼𝑣𝑣𝐴𝐴 is the power per unit solid angle (W ∙ sr−1) in virtual direction 𝑣𝑣 and 𝜃𝜃𝑣𝑣 is the zenith 
angle of the virtual direction. An advantage of calculating a directional BRF using virtual photon 
approach is that the BRF is estimated within an infinity small solid angle (Thompson and Goel, 
1998), which is the real directional BRF of a scene.

Figure 3. Virtual photon approach to calculate BRF.
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1.2. Backward path tracing (BPT)

Instead of tracing photon packets from light sources, backward path tracing sends rays from 
sensors into the scene. The ray directions are controlled by sensor configurations (field of view, 
position, orientation, etc.). The main task of this ray-tracing algorithm is to establish a connection, 
which is called “path”, between light sources and sensors and to determine the radiance incident 
onto the sensor. The radiance is estimated for every pixel in the output image. Radiance along 
direction oω can be calculated according to a rendering equation (Kajiya, 1986)

𝐿𝐿𝑜𝑜(𝑞𝑞,𝜔𝜔𝑜𝑜) = 𝐿𝐿𝑒𝑒(𝑞𝑞,𝜔𝜔𝑜𝑜) + ∫ 𝑓𝑓(𝑞𝑞,𝜔𝜔𝑖𝑖 ,𝜔𝜔𝑜𝑜)4𝜋𝜋 𝐿𝐿𝑖𝑖(𝑞𝑞,𝜔𝜔𝑖𝑖)|cos𝜃𝜃𝑖𝑖|𝑑𝑑𝜔𝜔𝑖𝑖 (9)
where 𝐿𝐿𝑜𝑜(𝑞𝑞,𝜔𝜔𝑜𝑜) is the outgoing radiance from point 𝑞𝑞 along direction 𝜔𝜔𝑜𝑜; 𝑓𝑓(𝑞𝑞,𝜔𝜔𝑖𝑖 ,𝜔𝜔𝑜𝑜) is the BSDF 
of the intersected surface, which determines the outgoing radiance along direction 𝜔𝜔𝑜𝑜  at point 𝑞𝑞 
induced by incoming radiance along direction 𝜔𝜔𝑖𝑖; 𝐿𝐿𝑖𝑖(𝑞𝑞,𝜔𝜔𝑖𝑖) is the incoming radiance; 𝜃𝜃𝑖𝑖 is the angle 
between 𝜔𝜔𝑖𝑖 and the surface normal and 𝐿𝐿𝑒𝑒(𝑞𝑞,𝜔𝜔𝑜𝑜) is an emission term (e.g., thermal emission), which 
is described in detail in section 2.4. The algorithm that solves this equation is illustrated in Figure 4. A 
ray from the sensor intersects the elements in the scene at the point 𝑞𝑞. The outgoing radiance induced by 
the sun (or sky) is then calculated according to the BSDF. To calculate the multiple scattering radiation, 
a new ray is launched from the point 𝑞𝑞 with a direction that randomly samples the BSDF. If this ray 
intersects the scene at another point 𝑞𝑞1, the same procedure is applied to 𝑞𝑞1. The outgoing radiance at 
point 𝑞𝑞1 along the randomly selected direction is the incoming radiance of 𝑞𝑞 along direction 𝜔𝜔1. The 
multiple scattering procedure is performed recursively until reaching the maximum scattering order (e.g., 
5) specified by the user. To prevent energy loss due to the termination of scattering, the random cut-off 
technique (“Russian roulette”) used in FPT is also applied to the sensor ray.

When simulating a horizontally infinite scene, the lateral boundary effect is considered for both the 
sensor ray and the illumination ray. At each intersected point (𝑞𝑞𝑖𝑖), an illumination ray, which is built by 
randomly sampling a point 𝑞𝑞𝑒𝑒 on the emitter, is sent towards the emitter. If this ray traverses the lateral 
boundary of the scene, it is also reintroduced into the scene to test whether the intersected point is 
occluded by other landscape elements or not.

Figure 4. Backward path tracing.

1.3. BPT in simulating thermal infrared brightness temperature (BT)

When simulating thermal infrared radiation, the object itself, instead of the sun, becomes an 
“emitter”, which emits thermal radiation according to Planck's law and its emissivity. Since the incident 
energy of the sun in thermal infrared bands (e.g., 10 mµ ) is too weak, we ignore this part of energy in 
our simulation. However, the presence of sun radiation will greatly influence the temperature distribution 
of objects due to the shadows cast between them. This generally classifies the scene elements into four 
components with specific temperatures, i.e., sunlit soil, shaded soil, sunlit leaves and shaded leaves 
(Figure 5). The determination of these four components is computed on the fly instead of a precomputing 
step adopted by most of other forward models (e.g., DART). This on-the-fly approach avoids the storage 
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of emission points, which can greatly reduce the memory usage, especially for scenes with a large number 
of leaves. 

If a sensor ray is intersected in the scene (i.e., 𝑞𝑞 in the scene), an emission term at this point is 
added. To determine the emission power, an occlusion ray is traced towards the sun. If this point is 
directly illuminated, i.e., the occlusion ray intersects nothing, the temperature of the sunlit component is 
used. Otherwise it uses the temperature of the shaded component. The emitted radiation is calculated by 
using Planck’s law with emissivity provided. Except for the emission term, another component of the 
power that goes into the sensor is the reflected power, which is emitted by other objects in the scene or 
sky radiation. In order to consider this part of the power, a random point on a randomly selected emitter 
(including the sky) is sampled (e.g., 𝑞𝑞𝑒𝑒 in Figure 5). When this point is not on the sky, the emission 
power is determined by sending an occlusion ray towards the sun. The contribution of power from this 
point is calculated by using the BSDF defined at point 𝑞𝑞 if this point is not occluded by other objects. 
This procedure can be recursively repeated, which is the same as the procedure described in section 2.2 
except for the emission term. Finally, a thermal infrared image, which records the radiance value, can be 
simulated.

Figure 5. Simulation of thermal infrared radiation using backward path tracing.

3. Installation
Windows

Download the installer from http://www.lessrt.org. All you need is just to choose a place to install it. 
(Usually, LESS cannot be installed in c:\program files, since it does not have administrative rights.). After 
installation, LESS will be automatically started. 

4. Graphic User Interface (GUI)
LESS window is divided into four areas (Figure 6):
 The area 1 is Preview Panel
 The area 2 is Parameter Control Panel
 The area 3 is Progress Panel
 The area 4 is Menu Panel

4.1. Preview Panel
Preview Panel  is for displaying some information, such as 
view azimuth angle ( ), sun azimuth angle ( ), sensor footprint 
(  ) and tree positions. This will make it easier for user to set parameters, because this display is 
automatically updated when related parameters are changing.
Background Image ( ) - When you click the icon, you can choose a picture as background image, make 
sure that the image represents the same area defined in LESS.
Delete Background Image ( ) - When you click the icon, background image will be delete.
Zoom-in ( ) - This icon allows you to zoom-in the area covered by grids.

Figure 6. Main Screen of LESS

http://www.lessrt.org/
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Zoom-out ( ) - This icon allows you to zoom-out the area covered by grids.
3D Viewer ( ) - If you click this icon, 3D Viewer will be activated. In 3D Viewer windows, you can 
visualize the scene in advance (before actual simulation) to verify the 3D scene.
Polygon ( ) - When you check the icon, you can draw a 
polygon in the area covered by grid and set polygon parameter 
(such as the minimum distance between trees, tree position in 
the polygon) in the panel after it ( ). If you just 
want to allocate objects in some particular areas, the solution is 
using Polygon tool. Check the option of Polygon under the 
display panel. This time when your mouse enters the display 
panel, it will become a hand. you can create a polygon by left 
click. If you want to remove the polygon, just use your right click of mouse. After the creation of polygon, 
you can delete or add object instances in this area. If you click Add, then all the generated instances will 
only apprear in the polygon, the position and number of each object are still random within the polygon. 
However, if you choose one of the objects in the Objects List. then the generated instances only contains 
this object. This tool can create some forest scene which contains one species of trees in some area and 
another species of tree in another areas.
Point ( ) - When you check the icon, you will see the cursor changing to a hand. You can choose the 
position of tree by clicking the place where you want the tree to be, without inputting coordinates.

4.2. Parameter Control Panel
Parameter Control Panel  is for setting parameter which can control the scene you simulate.

4.2.1. Sensor

To simulate a sensor you can input parameters here to control image type, the number of pixels in 
width and height, sample count per pixel.
Type - Up to now, there are four types that you can choose. They are orthographic, perspective, 
CircularFisheye, PhotonTracing.
Width - The number of pixels in width.
Height - The number of pixels in height.
Samples - sample count per square meter. Usually 128 is sufficient. If you increase to 256, 512, the 
quality of the simulated image will be better. 
Spectral Bands - It represents the which band you want to 
simulate. For example, RED and NIR: 660nm，900nm. Now, you 
must also input a bandwidth for each band with the format 
of “center band: bandwidths”, e.g. 660:10,900:10. These 
bandwidths will be used for determining the irradiance. If you 
have no special requirement, it can just set the bandwidth to zero. 
And when you click [Define], you can define the bands by input 
some parameter in the pop-up window (Figure 8).

Image Format - “Spectrum” means generating spectral image. 
“Synthesized RGB Image” means generating RGB image.
Only First Order? - If it is true, it means LESS only simulate the first-scattering event (sun * radiation 
reflected by objects only one time). If set to false, then both first-scattering and multi-scatting will be 
simulated.
Virtual Plane – When you check it, a virtual plane is defined, and only the radiant that exits through the 
plane is calculated. In Figure 9, you 
can define the location of the virtual 
plane in “Center” and the size of the 

  Figure 7. Polygon tools    

Figure 8. Spectral bands

Figure 9. Virtual plane
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virtual plane in “Size”. Usually, the height of the plane (Z) should be left as default, i.e., MAX.
Thermal Radiation - When you 
need to get thermal infrared image, 
you can check it. After checking, 
you can input surface temperature 
parameter in Optical Database 
(Figure 10).
NoData Value - Set the background 
value when sensor footprint is 
beyond the scene scale. If the image opened by ENVI, you should set it as “0”.
Repetitive scene - Sets the number of copies that distributed around the scene.
Width Extent/Height Extent - The actual extend of the orthographic sensor can simulate. It is similar to 
FOV of perspective sensor. 
Four Components Product - If you check it, a classification image will be generated. The classification 
image has four components, and they are sunlit ground, sunlit canopy, shaded ground and shaded canopy. 
The corresponding pixel values are 1, 2, 3 and 4, respectively. Please note that some pixels may mixed 
pixels, in this case, the dominant component is set as the pixel component type. However, if you set the 
number of bands >= 5, the generated four component image will contain 5 spectral bands, the first band 
is the classification image, the other four bands are the proportions of the four components. This can be 
used to estimate directional gap fraction of forest canopy.

4.2.2. Observation

View Zenith - Set view zenith angle (angle between vertical direction).
View Azimuth - Set view azimuth（0° is north, clock-wise to 360°).
Sensor Height - Set the height of the sensor.

4.2.3. Illumination & Atmosphere

There are two groups of illuminations, one is from sun, other is from atmosphere.
Sun Zenith - Zenith angle of sun.
Sun Azimuth - Azimuth angle of sun (0° is north, clock-wise to 360°).
This defines the position of sun. That means if you set it as 90° (East), then it will produce shadows in 
West. 
Sun Position Calculator - If you clicked it, you can fill in above two parameters by inputting the time and 
place parameters for the scene.
Next is the parameter setting for the sky.
Type - It represents the type of atmosphere radiation, now only one option can be used - 
“SKY_TO_TOTAL”，it means the ratio between diffuse radiation and total incident radiation. Thus (1-
SKYL) * T (T is sun radiation above atmosphere) is the sun radiation under atmosphere. Under this mode, 
atmosphere is isotropic diffuse radiation from upper hemisphere.
Percentage - It defines the actual ratio between atmosphere radiation and total radiation. What should be 
noticed is that when you input the values, the number of values should be equal to the number of bands 
(under the sensor section). That is, for each band, it may have different values.
Input solar spectrum manually - If you check it, you can input the solar spectrum and the sky spectral in 
terms of wavelength manually (in W/m2/nm).

4.2.4. Optical Database

Since objects in LESS are represented as triangular meshes, thus for each triangle, it can have at 
least three kinds of optical properties: reflectance of front side, reflectance of back side, and transmittance 
(we assume transmittance of both side is the same). In Optical database, we should first define some 
optical model, and then they can be used in the following terrain or forest definition. By default, there 

Figure 10. Temperature definition
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are three optical models defined. Please note that, these three optical models cannot be modified, if you 
want to use them with modified value, you should copy a new one and then perform the modification 
You can also add new optical model directly. For each reflectance or transmittance, values of different 
bands are connected by comma.

Please note that for some object component, such as trunk, the normal of some triangles may face 
inside, which shows a zero reflectance outside. To avoid this situation, a convenient solution is to set the 
reflectance of both outer and inner side to the same values, but with zero transmittance.

4.2.5. Terrain

There are mainly three types of terrain: PLANE, RASTER, MESH.
PLANE just represents simple plane lies at altitude of 0. RASTER is a raster image file in ENVI standard 
format.
XSize - Size in the X direction.
YSize - Size in the Y direction.
There are two BRDF types: Lambertian, Soilspect. If Lambertian is chosen, it means you think of the 
ground as a Lambertian. If Soilspect is chosen , you can input parameters to define the model.
Land Cover - If you check it, you can input surface classification data generated by ENVI, and then set 
different spectrum for different ground classes.

4.2.6. Objects

Objects define what you want to put in the scene. For example, forest is formed by a number of 
single trees, which are describe by triangle mesh (obj file) in LESS. Usually, we cannot input a obj for 
each single trees, since forest contains a lot of trees and a tree itself contains numerous triangles, it may 
not be possible even for large memory computers. The alternative is to use a “instance” technique. That 
means we define a single tree, and we can place it at different places, just using reference, thus the 
program only keeps one copy of the triangle mesh, but it represents trees at different places (they have 
exactly the same structures, but we can do rigid transformations). 
Objects window is divided into three areas:
• The area (1) is Objects Define Panel;
• The area (2) is Position Parameter Control Panel;
• The area (3) is Display Panel.
(1) Objects Define Panel
The first step is to define some objects (single tree). 
Define Object… - You can click it to define objects. It will open a 
new dialog that allows to import obj file (Figure 11).
Add - We give a name for our first object, such as “birch”. After 
clicking [Add] button, “birch” will appear in the Objects list.
Import OBJ - Selecting the name we write in “Objects” area, then the button [Import OBJ] is activated. 
If you click the [Import OBJ], you can choose a obj file 
in the window and input it as the object (Figure 12). 
And then you need to determine the scale by the units 
of the tree model that you enter into. If the units of the 
tree model that you enter into is “cm”, the scale should 
be 0.01. And if the units of the tree model that you 
enter into is “m”, the scale should be 1.00.
Import from RAMI - Import objects from the model 
file on the rami website. After importing objects, each component of the obj file will appear in the 
“Components” list. Component is a part of the object, e.g. a tree contains leaves and branches (usually 
they have different optical properties). You should be aware that the obj file itself will be copied to 
the simulation folder, so you can safely delete it from your original place.

Figure 11. Objects definition

Figure 12. Import obj file
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Optical Property - Selecting one of the components, the [Optical Property] is activated and you can 
choose an optical property for the selected component. These optical properties are also from “Optical 
Database”. If you need to define a new optical model, you can go back to “Optical Database” page 
without closing the current window. When you finish, the optical models are automatically synchronized.
3D Display - After clicking it, you can see the 3D model of object (Figure 13).
After defining objects, you should click [OK] button, and 
then we will go back to Objects page with the defined 
objects shown in Objects list.
(2) Position Parameter Control Panel
If we select the defined objects, we can define its positions. 
There are three methods to define positions. The first 
method is inputting coordinate for the object directly. The 
second method is using [Point] tool provided by LESS 
(introduced in Preview Panel). The third method is using 
[Random] tool provided by LESS. The last method is 
import CHM data to control position.
Add - You can enter coordinates in the table before [Add] button, and then clicking [Add], the object is 
added to the specified location.
Random - Clicking the button [Random], it will open a new window, now the only choice is Poisson 
distribution (This is very normal for trees in forest). The only parameter you need to provide is the 
minimum distance between two objects. Click [OK], then LESS will automatically generate instances of 
defined objects. The number and position of each object in the Objects list is also random. Thus, you can 
get a reasonable distribution of objects.
From CHM - Clicking the inverted triangle next to the button [Random], you can open the drop-down 
menu, and find the [From CHM] button. If click it, you can choose a CHM data as a basis for objects 
location.
(3) Display Panel
Display on 2D map - If a position is added when you check it, the position will appear on the grid area 
in Preview Panel, which will help you to check whether it is correct.
Hide selected Objects - If there are multiple plants in this scene, you can hide the location of the model 
you don't want to see by checking it.

4.3. Progress Panel
This panel shows the running state of the current program. When an error occurs, you can find the 

reason of the error by reading this panel.

4.4. Menu Panel
Menu bar holds 6 menus:  File, Run, Tools, Display, Process and Help

4.4.1. File menu

File > New Simulation - Create a new simulation.
File > Open Simulation - Open a chosen LESS file and load its parameter values into LESS modeler.
File > Save - Save current parameter values on a disk as LESS file.
File > Save as - Save the tree image into another file.
File > Close - Close the simulation.

4.4.2. Run menu

Run > Run All - Run this program and output results.
Run > Generate 3D Model - Generate 3D objects, e.g., convert obj file into binary format.
Run > Generate View & Illumination - Generate viewing parameters for simulation.
Run > less - Run less simulation

Figure 13. 3D Display
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4.4.3. Tools menu

Tools > Open Results Folder - Open Results Folder of current simulation.
Tools > Batch Tools - Do batch processing.
Tools > Server Setting - Do network parallel simulation
Tools > LAI Calculator - Calculate LAI in different resolution, and output the results as txt.
Tools > Python Console - Run Python scripts (under experiment).

4.4.4. Display menu

Display > 3D Viewer - Display scene you simulate from multiple angles.
Display > 3D Viewer (Bounding BOX) - Display scene you simulate from multiple angles with replacing 
objects with boxes.
Display > 2D Polygon - Draw a polygon in the area covered by grid and set polygon parameter (such as 
the minimum distance between trees, tree position in the polygon) in the panel after it.

4.4.5. Process menu

Process > BRF Processing - Generate BRF image.
Process > Brightness Temperature Processing 

4.4.6. Help menu

Help > Documentation - Documentation of LESS.

5. Examples

5.1. FPAR simulation
FPAR is the fraction of total absorbed radiation, usually from 400 to 700 nm. Therefore, to simulate 

FPAR using LESS, we need first to set the band range from 400 to 700 nm (or other spectrum if you 
want), the band number can be, e.g., 30. Then you need to set the leaf and soil optical properties in 
[Optical Database] section, the number of spectrum bands should be the same with the band number 
you set in the [Sensor] section, e.g., the 30 you have previously set.

Figure 14. Set the spectral bands for FPAR simulation.

Next step is to enable the FPAR option in [sensor] section as illustrated in Figure 15. An important 
parameter is the Layer definition (Start:Interval:End), which defines how FPAR is outputted. 
Specifically, LESS only outputs the FPAR values between Start and End range with interval equal to 
Interval. For example, if you define it as 0:2:10, then you will get FPAR for layers: [0,2), [2,4) , [4,6) , 
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[6,8) , [8,10). 

  
Figure 15. Enable FPAR simulation in LESS and define layers.

A simulation example is shown in Figure 16, the file can be found in the Results folder within the 
simulation folder. The results five two kinds of product, one is the spectrally integrated total FPAR, the 
other is the absorption for each band. For each layer, we first integrate the total PAR over the whole 
spectrum range, and then divided by the total incident energy received by a plane at the top of the canopy 
（also integrated over the whole spectrum range）(Figure 16). The total FPAR is presented at the top 
of the result file ((Figure 16 left), it illustrates the total FPAR (TfPAR) for each layers, e.g., from 0 m to 
2 m, the total FPAR is 0.3839, which may be mainly absorbed by soil. If you are interested in leaves, 
maybe you should look at the 4th column, it outputs the FPAR for the leave components. Please note that 
the name of the column is not fixed, it is according to the component you defined in LESS when you 
import your OBJ file into LESS. If you don’t want the spectrally integrated FPAR, you can refer to the 
**Absorption for each band**, here, the FPAR for each band is presented. ‘- Total Absorption’ means 
the total absorbed energy for all the landscape components (e.g., leaves, soil and branches) for each band. 
The column means the spectral bands, thus you would see 32 columns if you set the spectral bands to 30, 
the first two columns are layer heights. Next content is the FPAR or absorption for other landscape 
components, for example the tree_leaves. In conclusion, if you are interested in the total and spectrally 
integrated FPAR, you only need to refer to the first section of the result file.

 
Figure 16. FPAR simulation example: simulation results (left); total FPAR calculation.

5.2. LiDAR simulations
Up to now, less has provided airborne laser scanning (ALS) and ground laser scanning (TLS) data 

simulation in graphical user interface, The simulator can get different types of data through file 
configuration, such as full waveform and 3D point cloud data, including single-band, multi-band and 
even hyperspectral LiDAR scanning (HLS) data. The laser simulator is located in GUI extension module. 
You should use the mouse to indicate [Extensions] and click on the button [LiDAR Simulator]. You can 
see Figure 17 for the specific operation of opening the simulator.
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Figure 17.  LiDAR simulator interface

Before starting the simulation, you also need to understand the configuration of each parameter 
so that you can get interested LiDAR data in the simulator. Parameters are divided into two 
categories. The sensor parameters are located on the left side of the GUI, and the platform 
parameters are located on the right side. The meaning of each parameter is presented in Table 1, 
Table 2 and Table 3, Some parameters are also presented in Figure 18 to help users better understand.

Table1. Sensor parameters

Sensor Area
Sensor size (area) of LiDAR receiving energy, The sensor size (area) 
of LiDAR receiving energy, the larger the sensor area, the more 
energy it can receive.

Footprint half angle Field angle of LiDAR pulse. Note: This is half of the cone angle of 
the field of view.

FOV half angle

FOV represents the field of view range of LiDAR receiving energy, 
which is set to half of the cone angle of the field of view. The larger 
the value, the larger the acceptable range. Generally, you need to set 
FOV half angle larger than footprint half angle. See Figure. 15 
specifically

Acquisition rate 
(Period)

The acquisition rate represents a certain sampling interval and is 
usually determined by the instrument itself.

Half duration (Number 
of sigma)

The emission energy of laser pulse is usually assumed to be a 
Gaussian distribution function related to time and amplitude. 
±3σrepresents the effective information range of the whole pulse 
energy. Note: Half duration represents half of the effective energy 
range.

Half pulse duration at 
half peak

Half pulse duration at half peak represents the standard deviation of 
Gaussian pulse energy. Half duration and Half pulse duration at half 
peak together determine the effective information range of pulse 
energy.

Axial division

The cross section of laser pulse is divided into n*n equal parts, and 
then sub-beams are emitted. The n here is the Axial division. This is 
only valid for multi-ray point cloud simulation. The larger the value, 
the finer the simulation of each pulse, but the simulation time is 
longer.
Table 2. ALS platform parameters

Altitude
The flying height of the platform where the LiDAR is located, which 
is relative to the zero point of the scene rather than the terrain. See 
Figure. 15 specifically.

StartX, StartY, EndX, 
EndY

The start point and end point of ALS scanning, the projection of these 
points on the ground, the platform will fly in a straight line from the 
point (StartX, StartY, Altitude) to (EndX, EndY, Altitude). See 
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Figure. 15 specifically.

Swath width Width of Lidar scanning (horizontal width of vertical to flight 
direction). See Figure. 15 specifically.

Along track resolution
(Yaw resolution)

Pulse interval along flight direction (ground distance). See Figure. 15 
specifically.

Cross track resolution
(Range resolution)

Pulse interval of vertical to flight direction (ground distance). See 
Figure. 15 specifically.

Min range, Max range
The range data [Min range, Max range] in this vertical direction can 
be collected and saved by the LiDAR sensor. See Figure. 15 
specifically.
Table 3. TLS platform parameters

TLS position X, Y, Z Location of TLS scanning. X, Y is the horizontal projection position 
of the ground, and Z is the height of the instrument.

Center zenith,
Center azimuth The position of the bisector of zenith angle or azimuth angle.

Delta zenith,
Delta azimuth

Range size of zenith angle or azimuth angle. Zenith angle range is 
generally set from 0 to180. Azimuth angle range is generally set from 
0 to 360.

Resolution zenith,
Resolution azimuth

The angle formed by two connected sampling points in zenith angle 
or azimuth is called angular resolution. The higher the angular 
resolution, the higher the point cloud density.

Cross track resolution
(Range resolution)

Pulse interval of vertical to flight direction (ground distance). See 
Figure. 15 specifically.

Echo Detection Model
LiDAR simulator provides two detection modes, one is simple and 
the other is Gaussian. Gaussian decomposition is used to solve the 
parameters, and the waveform is decomposed to obtain discrete 
points, so the simulation is slow but accurate.

Figure 18.  Illustration of LiDAR related parameters

5.2.1. Discrete point cloud data simulation

Note that before starting the simulation, you must build a project and configure the scenes you 
are interested in according to the operation tutorial in section 4.2. Furthermore, you need to 
configure the parameters of sensors and platforms according to the simulator interface. Finally, you 
can start your discrete point cloud simulation work. Using the mouse to indicate [RUN] and click 
the button [Generate ALL], The simulator starts to generate 3D scenes and LiDAR configuration 
parameters. Then click button [Single ray point cloud] or button [Multi rays point cloud] to 
simulate point cloud. The former emits one light for each pulse, so the computer is faster. The latter 
emits multiple rays for each pulse (the number is determined by Axial division). In this mode, the 
full waveform is first simulated internally, and then discrete points are obtained by Gaussian 
decomposition, so the calculation speed is slower than [Single ray point cloud] mode. The 
simulation results can be found in the Results file. The results of two different modes correspond to 
singleRay and pointcloud folder. The results of point cloud generated by [Single ray point cloud] 
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and [Multi rays point cloud] are presented in Figure 19, respectively.

  
Figure 19.  Simulation results of single ray point cloud (left); Simulation results of multi ray point cloud 
(right).

 Single ray point cloud simulation results

Single ray point cloud simulation results are located in the singleRay folder, the results of 
single ray point cloud simulation record the XYZ coordinates, intensity and other related 
information of discrete point cloud data (Figure16). Less In order to meet the needs of different 
users, better use LiDAR simulator to obtain more useful data. It is worth noting that when users 
input spectral information of different bands, multi-spectral or even hyperspectral discrete point 
cloud data will be obtained in [Single ray point cloud] mode. At the same time, the [Single ray

point cloud] mode may provide users with more humanized data, and the simulation results also 
record the types of ground objects that each pulse touches during transmission, which may make 
users analysis more convenient. Different types of ground objects touched by lidar pulses are 
recorded in the last column of the result file. An example of simulating discrete point clouds with a 
single ray is shown in Figure 20.

Figure 20.  Example of simulating discrete point cloud with single ray.

 Multi ray point cloud simulation results

Multi ray point cloud simulation results are located in the pointcloud folder, the results of 
Multi ray point cloud simulation record the XYZ coordinates, Return Number, Number of Return, 
intensity and other related information of discrete point cloud data (Figure17). Note that the result 
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file also records the band index fields of different point clouds. Therefore, multispectral or even 
hyperspectral discrete point cloud data acquisition is also supported in [Multi rays point cloud] 
mode. Compared with [Single ray point cloud] mode, [Multi rays point cloud] mode requires 
users to further filter and separate the discrete point cloud data of different bands according to the 
band index fields. An example of simulating discrete point clouds with a Multi rays are shown in 
Figure 21.

Figure 21.  Example of simulating discrete point cloud with multi ray.

The above shows the LiDAR point cloud data simulated in two different modes: [Single ray 
point cloud] and [Multi rays point cloud]. Compared with [Multi rays point cloud] mode, [Single 
ray point cloud] provides more friendly simulation results, which is convenient for users to further 
analyze. [Multi rays point cloud] mode obtains finer results，In the above example, two different 
modes simulate the same scene, and the number of point clouds obtained by [Single ray point cloud] 
mode and [Multi rays point cloud] mode is 2091 and 6172 respectively. 

Of course, in addition to the above two modes, LESS also provides an advanced mode of 
[Multi rays point cloud]. The user can use the mouse to indicate [Advanced] and click the [Muti 
rays point cloud incident] button (Figure 20). Like other simulation forms, users can find the 
results of advanced version simulation in the Results folder. The corresponding folder is 
pointcloudIncident. [Muti rays point cloud incident] mode is based on the development of [Multi 
rays point cloud] mode, Therefore, the simulation results not only record the results of [Multi rays 
point cloud] mode, but also record the incident energy of each pulse and the energy intercepted by 
ground objects during the pulse transmission, Incident energy and intercepted energy are recorded 
in the last two columns in the result file respectively. Different modes depend on the research needs 
of users, which also allows users to choose different modes of simulation data more flexibly.

  
Figure 22.  Example of simulating Muti rays point cloud with incident mode.

5.2.2. Full-waveform Multi/Hyperspectral Lidar
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Using the mouse to indicate [RUN] and click the button [Generate ALL], The simulator starts 
to generate 3D scenes and LiDAR configuration parameters. Then click button [Single ray point

cloud] or button [Multi rays waveform] to simulate the data. The simulation results can be found 
in the Results folder. The results of two different modes correspond to singleRay and records folder. 
However, the result is only the data of intermediate process, which is not the full waveform data 
that can be used effectively. Using the mouse to indicate [Process] and click button [Convolve] to 
perform convolution operation. Finally, the full waveform data is obtained, and the results can be 
found in convolved_waveform folder. This result is composed of two files, It's 0.txt and pos_0.txt 
respectively (Figure 23).
[0.txt] records all waveform data.

The number of pulses is the number of rows of recorded data divided by bins in which each 
pulse is dispersed. Therefore, the first pulse is 0 to the NumberofBinsForEachPulse-1 line. 
The second pulse is NumberofBinsForEachPulse to the 2* NumberofBinsForEachPulse-1 
line. By analogy, all pulses can be read. The first column of the file is the distance from the 
starting position of each pulse bin to the sensor, and the second column to the last column is 
the echo intensity of each band. The visualization of full waveform multispectral LiDAR data 
is shown in.

[Pos_1.txt] records the position information of the pulse. 
The first three columns are the XYZ coordinates of the pulse starting position, that is the sensor 
position. The last three columns are the reflection direction of each pulse, at the same time, the 
coordinate system is consistent with the coordinate system of LESS GUI.

  
Figure 23. Example of 0.txt (left); example of pos_0.txt (middle); simulated hyperspectral waveform 
(right).
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